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Minitel/MAC Technical Documentation
The following documents MINITEL SERVICES COMPANY's Minitel terminal 
emulator (Minitel/MAC). This software allows your Macintosh computer to 
imitate a Minitel, VT100 or TTY terminal.

1.0  Hardware and Operating System Requirements 

Minitel/MAC requires the following hardware/software configuration:

  - Mac 512KE, Mac Plus, Mac SE, Mac II, Mac IIx or Mac IIcx
    computer with ROM version 117 or higher (128K ROM)
  - System version 3.2 or higher
  - A hard disk drive is not required

Minitel/MAC uses the following Macintosh features that are not supported by 
the 64K ROMs.

i) RAM serial driver
ii) Zoom windows
iii) List manager
iv) The TextEdit procedures TEPinScroll and TEAutoView.

2.0  Installing Minitel/MAC 

If you plan to run Minitel/MAC from a floppy disk, no installation has to be 
done. If you want to run Minitel/MAC from a hard drive, drag all of the files on
the distribution diskette to a folder on your hard drive.

3.0  How to run Minitel/MAC 

To run Minitel/MAC put the distribution diskette in any floppy drive, then 
double click on the ICON labelled 'mt.cfg' (this starts Minitel/MAC using the 
configuration file 'mt.cfg'). If you create other configuration files (using the 
FILE menu) you will also be able to start Minitel/MAC by double clicking on 
those configuration files. See Appendix A for more details on starting 
Minitel/MAC.

Once the Minitel/MAC has started:
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i) Review the HELP menus.

ii) Use the OPTION menu to make configuration changes for your system. 
In particular the modem type, telephone #, and user id/password 
options should be set. If you have a color MAC, or a MAC that displays 
multiple grey scales, you should also click the color radio button in the 
terminal options dialog.

If you don't have a User Id/password yet, don't enter a User Id or 
password in the User Id/password dialog. The first time that you access 
the Minitel network you will be assigned a User Id and password. At that 
time you can go back and enter this information.

iii) Click the LOGON button at the right side of the terminal window to 
automatically logon to the Minitel network.

3.1  The Minitel Function Keys

A real Minitel terminal has nine special keys (called function keys) that are 
not on the MAC keyboard. The nine special keys are labelled INDEX, CANCEL, 
PREVIOUS, REPEAT, GUIDE, CORRECTION, NEXT, SEND and LOCAL/LINE. Since
these keys are not available on the MAC keyboard, buttons at the right side 
of the terminal window are used as replacements. The Minitel special keys 
also have replacements on the MAC keyboard. For example if a service asks 
you to press the SEND key you can either click the SEND button or press the 
ENTER key. The following table shows the mapping of the Minitel function 
keys to their equivalents on the MAC keyboard.

English Minitel Key 
Labeling

MAC Key Equivalent(s) French Minitel 
Key Labeling

INDEX [command][I] or [home] SOMMAIRE
CANCEL [clear] ANNULATION
PREVIOUS [command][-] or [page up] RETOUR
REPEAT [command][R] REPETITION
GUIDE [command][G] GUIDE
CORRECTION [delete] CORRECTION
NEXT [command][+] or [page 

down]
SUITE

SEND [return] ENVOI
LOCAL LINE [command][L] CONNEXION FIN
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From within Minitel/MAC you can select 'Function Key Table...' from the HELP 
menu to get a table showing the above Minitel function key mapping. Most of
the buttons also show their keyboard equivalents. See Appendix D for the 
complete mapping of the Minitel keyboard to the MAC keyboard.

Of the Minitel function keys the most commonly used ones are SEND which is
used like ENTER (or Return) on a normal terminal, CORRECTION which allows 
you to correct your typing errors (I use this one a lot) and GUIDE which is 
used to request help from the service you are using. See Appendix G for a 
more complete description of the uses of the Minitel function keys.

As shown in the above table Minitel/MAC uses the return key and the delete 
key to emulate the minitel SEND and CORRECTION keys respectively.  
Occasionally when using Minitel/MAC it is necessary to send a real return or a
real delete. This is necessary for example when issuing commands to your 
modem or a network.  Commands to your modem must be followed by a real
return and not a minitel SEND. Corrections to errors in modem commands 
must be made with a delete and not a minitel CORRECTION.  The following 
table shows the key combinations that are used to replace the return and 
delete keys within Minitel/MAC.

To Send Use

Real return [option][return] (i.e. hold down the 
option key then press return)

Real delete [option][delete] (i.e. hold down the 
option key then press delete)

3.2  Using Minitel/MAC

Minitel/MAC has some advantages over a real Minitel. These are described in 
this section.

3.2.1  Auto-Logon

At the lower right side of the terminal window you will find the following two 
buttons which control your link with the Minitel network.
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Button Use Keyboard equivalent

LOGON Logon to Network [command][D]
CHNG SRV Change Service [command][2]

The LOGON button automatically connects you to the Minitel network. Once 
you have connected to the Minitel Network you can select a service using the
menus.

When you are finished using a service you can click the CHNG SRV button to 
return you to the menu so that you can select another service.

When you have finished using the Minitel services you can select "Quit & 
Drop Line" from the File menu to disconnect you from the Minitel network 
and exit from Minitel/MAC.

3.2.2  Stopwatch timer

An on-screen stopwatch timer is provided to help you keep track of the 
length of time that you have been connected to a service.

The timer displays the elapsed time since you started Minitel/MAC. The 
button labelled 'R' beside the time display can be used to reset the timer 
zero.

3.2.3  Screen clicking

Clicking on a word (or number) on the screen causes that word and a SEND 
key to be transmitted to the service that you are using. This is useful when a 
menu is displayed on the screen. When a menu is displayed on the screen, 
click on the menu option that you want to select and Minitel/MAC will send 
that option followed by a SEND key to the service. For example suppose that 
the service you are using displays the following menu.

1. Email
2. Chat
3. Games

.

.

.
10. Other options
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Enter # and [SEND] to select an option

If you want to select option three (games) just click on the '3' and 
Minitel/MAC will send the '3' followed by a SEND key.

When you click on the '3' it is highlighted. The highlighted area lets you know
what will be sent when you release the mouse button. If you decide that you 
don't want that option just move the cursor off of the highlighted area before
releasing the mouse button. Clicking a word on the screen behaves just like 
clicking an on-screen button.

If you had clicked on option '10' both the '1' and the '0' would have been 
highlighted. Minitel/MAC always selects the entire word surrounding the 
character that you click on. For the purposes of a selection a word is defined 
as a sequence of alphanumeric characters (alphanumeric refers to the letters
'A' thru 'Z' and 'a' thru 'z' and the digits '0' thru '9'). In other words when you 
click on an alphanumeric chararacter Minitel/MAC selects all alphanumeric 
characters to the left and right of that character. If you click on a non-
alphanumeric character, only that character is selected.

Another common type of menu, requires you to enter a string of characters 
to select an option. For example.

EMAI Electronic Mail
CHAT Online conversation
GAMEPlay electronic games

.

.

.
OTHE Other options

Enter option followed by [SEND]

In the above example click on the word 'GAME' to play games. After you 
release the mouse button Minitel/MAC will send the word 'GAME' followed by 
a SEND key.

To prevent Minitel/MAC from sending a SEND key after sending the selection, 
hold down the SHIFT key prior to clicking on the word. In some situations you
will not want Minitel/MAC to send a SEND key 
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after the string. For example assume that the above menu included the 
following extra line at the bottom.

Enter option followed by "?" and [SEND] for Help

In this case, to get help on games, hold down the SHIFT key, click on the 
word GAME, release the shift key, then click on the question mark character. 
This causes the word GAME to be sent, followed by a question mark, followed
by a SEND key.

Another feature is that if you click on a word that is the name of a Minitel 
function key, Minitel/MAC will send the value of the function key rather than 
the word and a SEND key. For example you will often see prompts like the 
following at the bottom of screens.

Press [PREVIOUS] for previous page
Press [NEXT] for next page
Press [INDEX] to return to menu
Press [GUIDE] for help

In this case the service wants you to press a Minitel function key rather than 
type in a response. In the above example, click on the word NEXT to go to 
the next page. Minitel/MAC recognizes this word as the name of a Minitel 
function key and will send the value for the function key NEXT rather than 
the word 'NEXT'.

Minitel/MAC recognizes the following function key names.

INDEX SOMMAIRE
CANCEL ANNULATION
PREVIOUS RETOUR
REPEAT REPETITION
GUIDE
CORRECTION
NEXT SUITE
SEND ENVOI

The function key names are recognized even if they are in lower case or in 
mixed case (i.e. some letters of name in upper case and other in lower case).
Note that the LOCAL/LINE key is not supported so don't click on the string 
LOCAL/LINE unless you want the words LOCAL or LINE to be sent.
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If you click on a Minitel function key name and the function key name is 
preceeded by an asterisk, Minitel/MAC will send the asterisk followed by the 
value of the function key. Preceeding asterisks are used in some services to 
modify the meaning of a function key (see Appendix G, "Use of the Minitel 
Function Keys" for more details). Minitel/MAC will find the asterisk even if 
there are one or more spaces between the asterisk and the function key 
name.

Occasionally you will want to click on a string that does not match 
Minitel/MACs definition of a word, for example 'GAME 1'. There is a space 
between the word GAME and the number one, so if you click on the word 
GAME only GAME is selected, if you click on the '1', only the '1' is selected. In
this case you can use the command key (apple key).  Holding down the 
command key prior to clicking the mouse button tells Minitel/MAC that you 
want to manually show it where the word starts and ends. To select the word 
'GAME 1', hold down the command key, click on the letter 'G' of the word 
'GAME' (the letter 'G' will be selected), continue holding down the mouse 
button and move the mouse to the right (as you move the mouse to the right
the characters 'AME 1' will become highlighted). Once you have selected 
everything, release the mouse button and the string 'GAME 1' followed by a 
SEND key will be sent. You can use the command and shift keys together to 
manually select a string and not have the SEND key added at the end. 
Manually selecting a function key name, such as SEND or a word, such as 
'GAME', is the same as automatically selecting them.

4.0  Menus (Commands) 

The Minitel/MAC menu bar contains the following titles.

Apple Menu (see section 4.1)
File (see section 4.2)
Edit (see section 4.3)
Options (see section 4.4)
PF Keys (see section 4.5)
Help (see section 4.6)

4.1  Apple Menu

As well as containing a list of available desk accessories this menu also 
contains the command 'About Minitel/MAC...'. Selecting this 
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command causes a dialog box containing the application version and 
copyright notice to be displayed.
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4.2  File Menu

The File menu contains the following commands.

-------------------
New Config
Open Config... #O
-------------------
Close Config #W
Save Config #S
Save Config As...
Revert to Saved Config
-------------------
Print Screen... #P
Save Screen... #S
Load Screen...
Session Capture…
-------------------
Run Script...
-------------------
Quit #E
Quit & Drop Line #Q
-------------------

4.2.1  Configuration file commands

The first six commands on the file menu (New, Open, Close, Save, Save As, 
and Revert to Saved) are used for manipulating configuration files. 
Configuration files are used to save all of your option and PF Key settings 
between sessions. A single configuration file, named 'mt.cfg', is provided 
with Minitel/MAC. It is possible to have more than one configuration file. This 
is useful if you routinely access more than one service and you need to have 
different configuration parameters for each. Only one configuration can be 
active at a time. When a configuration file is active a window appears on the 
screen with the name of the configuration in the menu bar.

The Close command is used to close the currently active configuration. If any
changes have been made to the configuration (via the Options or PF Keys 
menus), Minitel/MAC will ask you if you want to save your changes to disk 
prior to closing. The Quit command automatically closes the active 
configuration (if there is one). You must close the currently active 
configuration before you can load a 



Minitel/MAC13 12/31/22
new one. Another way to activate the Close command is to click the 'Close 
box' at the upper left hand corner of the terminal window. Issuing the Close 
command when a desk accessory is active causes the currently active desk 
accessory to be closed.

The Save command saves any changes that you have made to the current 
configuration (via commands from the Options and PF Keys menus) to disk. 
Changes made to the configuration are only active for the current session, 
they must be saved to disk to make them permanent. It is not necessary to 
use the Save command as Minitel/MAC will automatically ask you if you want 
your changes saved prior to quitting. The save command is useful in 
situations where you are worried that a power failure will cause you to lose 
your changes.

To create a new configuration either the New command or the Save As 
command can be used.

To create a new configuration with the New command close the current 
configuration with the Close command, then issue the New command (by 
selecting New from the File menu). New causes a new configuration to be 
created containing default values for all of the option settings. The window 
for the new configuration will appear on the screen with a title of 'Untitled'. 
Prior to saving this configuration Minitel/MAC will ask you for the name that 
you want it saved as.

The Save As command creates a copy of the currently active configuration 
under a different name. A handy way to create new configuration files is to 
modify the currently active configuration using commands on the Options 
and PF Key menus, then use the Save As command to save the modified 
configuration to a new file.

To change configurations use the Close command to close the current 
configuration, then use the Open command to open a new one. The Open 
command prompts you for the name of the configuration to be used.

The Revert to Saved command can be used to revert the currently active 
configuration back to the state it was in when you last saved it to disk. This is
handy if you want to make some temporary changes to the current 
configuration (such as change the terminal type to Black and White), perform
some processing (such as printing), then revert back to the original settings.



Minitel/MAC14 12/31/22

4.2.2  Saving, Restoring & Printing the screen

4.2.2.1  Minitel emulation

The Print Screen command is used to send the contents of the terminal 
window to the printer. Printing can also be done off line by saving the screen 
to a disk file when on line (with the Save Screen command), loading it back 
again when off line (with the Load Screen command), then printing the 
screen with the Print command. Color printing is currently not supported. 
Prior to printing you must set the Terminal type to Black&White (using the 
Terminal command on the Options menu, or the B&W button at the lower 
right hand side of the terminal window). Also if you have a color Macintosh 
you must set the number of colors in the Control Panel (i.e. the Control Panel 
desk accessory on the Apple Menu) to two prior to printing.

The Save Screen command saves the current contents of the terminal 
window to a disk file. Before saving the screen Minitel/MAC prompts you for 
the name of the file in which you want the screen saved. The format in which
the screen is saved depends on the 'Screen Save Format' option that you 
have set. The screen save format options are Minitel/MAC, MacPaint and 
TEXT. You set the screen save option using the Terminal command on the 
Options menu. The Minitel/MAC format is the only one that can be loaded 
back in once it is saved. Files created in this format are compatible with 
those created by the 'Save Minitel Page(s)..' command of the MACTELL 3 
communication package (file type VTEX). Files saved in the MacPaint format 
(file type 'PNTG') can be loaded and manipulated by Apple's MacPaint 
application.  To save a file in MacPaint format the terminal type must be set 
to B&W and the number of screen colors must be set to two (same 
restrictions as printing). Files created in the TEXT format can be loaded and 
manipulated by a text editor or word processor (file type TEXT).

The Load Screen command is used to load screens saved with the Save 
Screen command. Only files saved in the Minitel/MAC format can be loaded. 
It is possible to save screens when on line in the Minitel/MAC format, load 
them again when off line, then save them in another format such as 
MacPaint or TEXT. Occasionally screens that you save will not look correct or 
may be scrambled when you load them. If this happens try using the 
Terminal command (on the 
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Options menu) to switch the screen mode from PAGE to SCROLL (or vice 
versa) and then reload the screen.

4.2.2.2  TTY emulation

During TTY emulation only the TEXT format is available for saving screens. 
The Save Screen and Print Screen commands cause all data in the terminal 
buffer to be sent to a file and the printer respectively. The terminal buffer 
includes all data on and off the screen that can be viewed by using the scroll 
bars at the right side and bottom of the screen (default is up to 12,000 
characters). A subset of the terminal buffer can be printed/saved by selecting
the subset with the mouse prior to issuing the Print Screen or Save Screen 
command.

The are no restrictions on the number of screen colors or terminal settings 
when printing or saving screens when in the TTY emulation mode.

4.2.2.3  VT100 emulation

Currently saving and printing the screen is not supported during VT100 
emulation.

4.2.3  Session Capture

The 'Session Capture' command allows you to capture the text portion of an 
online session to disk. This session capture capablility works for all terminal 
emulations.(i.e. Minitel, VT100 and TTY).
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The 'Session Capture' command causes the following dialog to appear:

To start capturing your session, enter a file name in the 'Capture Session Text
To:' text box, use the radio buttons to select a capture technique (explained 
below), then click the 'Capture' button.

If capture is already on, you can change the capture file name and/or capture
technique and then click the 'Capture' button to continue capturing.

If capture is already on and you want to turn it off, click the 'Capt. OFF' 
button.

Whenever the session is being captured (i.e. capture is on) a check mark 
appears to the left of the 'Session Capture…' command on the file menu.

The following two capture techniques are available:
4.2.3.1  Line by Line

When using the 'Line by Line' technique Minitel/MAC will write out all text 
that has been received for the current row of the screen whenever it receives
text that is destined for a different row. With this technique you are 
guaranteed that all received text will be written to the capture file, but you 
are not guaranteed that the text 
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will appear in the capture file in the same order that it appears on the 
screen. For example if a service writes a line of text to row three of the 
screen and then writes a second line to row one of the screen, then row three
will appear in the capture file before row one.

During TTY emulation the 'Line by Line' technique is always used no matter 
what option you select.

4.2.3.2  Screen by Screen

When using the 'Screen by Screen' capture technique Minitel/MAC writes out 
all data on the current screen whenever it receives the start of a new screen 
(i.e. when it receives a clear screen or scroll command). This technique 
guarantees that text will be written to the capture file in the same order and 
placement that it appears on the screen, but does not guarantee that all 
received text will be saved to the capture file. For example in most CHAT 
services the screen is divided into three sections, a list of users, a received 
message area, and an area where you type in messages that you are 
sending. While you are chatting individual sections are rewritten with new 
data, but the screen is never cleared. Since the entire screen is rarely 
cleared very little will be written to the capture file. In cases like this you are 
better off using the 'Line by Line' capture technique.

Which is the best capture technique to use?

Finding out which is the best capture technique to use is a matter of 
experimentation. You are best off starting with the 'Line by Line' technique 
since this guarantees that all text will be captured. If when using the 'Line by
Line' technique you find that the lines are out of order, try the 'Screen by 
Screen' technique. In some services the 'Line by Line' technique will be 
better, while in others the 'Screen by Screen' technique will be better. In fact 
even within the same service different capture techniques may work better a
different times. Luckily, Minitel/Mac allows you to change capture techniques 
while capturing.

4.2.4  Quit command

The Quit command is used to exit from Minitel/MAC (return to the finder). The
Quit command does not drop the line, so use it only when you want to 
temporarily exit from Minitel/MAC. Remember you are billed by how long the 
line is active, so if you forget to 
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reactivate Minitel/MAC later to drop the line you could end up paying quite a 
large bill1.

If there is an active configuration and it has been changed, Minitel/MAC will 
ask you if you want to save the changes to that configuration. Clicking 
CANCEL here will cancel the quit command (also no save will be done).

4.2.5  Quit & Drop Line command

The Quit & Drop Line command is the same as the Quit command except 
that it drops the line before quitting2.

4.2.6  Run Script command

The Run Script command allows you to run a script language program 
created with the MTC compiler (provided with Minitel/MAC). See Appendix E 
for a complete discription of the Minitel/MAC script language. Scripts can also
be run by assigning them to program function keys (see section 4.5).

4.3  Edit Menu

The Edit menu contains the following commands.

-----------------
Undo #Z
-----------------
Cut #X
Copy #C
Paste #V
Clear
-----------------
Select All
-----------------

1You can also drop the line by turning off your modem.
2For HAYES modems the line is dropped by first sending three plus signs (++
+) to go into local mode and then issuing the ATH command. For other types 
of modems the line is dropped by dropping the RS232 DTR signal. In Minitel 
mode a LOCAL LINE key is sent prior to dropping the line to disconnect from 
the current service. If a LOGOFF_SCRIPT parameter is present in the 
configuration file a LOCAL LINE key is not sent and the logoff script is run 
before dropping the line.
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The Edit menu is only available when a desk accessory is active and during 
TTY emulation. See Appendix I (TTY emulation) for a complete description of 
the edit menu during TTY emulation.  The use of the Edit menu when a desk 
accessory is active depends on the desk accessory.
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4.4  Options Menu

The Options menu contains the following commands.

------------------
Modem...
Telephone #...
User ID...
------------------
Terminal...
Communications...
Modem Config...
------------------
Emulate Minitel
Emulate VT100
Emulate TTY
------------------

The commands on the options menu are used to set your preferences and to 
set parameters necessary for the operation of Minitel/MAC.

4.4.1  Modem Command

The Modem command is used to tell Minitel/MAC what type of modem that 
you have connected to your computer.

If you have an Apple Modem with no auto-dial capability, select one of the 
'Universal Apple Modem' options.

If you have a Hayes modem or a modem with a Hayes-compatible 'AT' 
command set, select one of the Hayes options.  The number in the Hayes 
options indicates the maximum speed of the modem.

If you have a non-Apple modem with no auto dial capability, select option 
six, 'Manual Dial'.

If you have an auto-dial modem that does not have a Hayes-compatible 'AT' 
command set, select option seven, 'Other'. If you select 'Other' here, you 
must use the Modem Config command to tell Minitel/MAC how to use your 
modem.

Note:
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If you select the Manual Dial, Other, or Direct modem options you will have 
to manually set the speed of the serial interface using the Communications 
command on the options menu.

4.4.2  Telephone # Command

The Telephone # command is used to tell Minitel/MAC which telephone 
number to use when dialing a remote system.

To enter a phone # perform the following steps:

i) Scroll through the list provided to find your local access number (or the 
closest number available). Once you have found the number click on it 
and the number will be placed in the Telephone # data entry field.

ii) If the number that you selected is a long distance call, click the 'Long 
distance call' check box, this causes the area code to be prepended to 
the number.

iii) If you must dial a nine to get an outside line, click the 'Dial 9 for outside 
line' check box, this causes a '9,' to be prepended to the number. If you 
have another number such as 8 that you must dial to get an outside line,
you can manually change the 9 to an 8. With a Hayes modem the 
comma causes a temporary delay during dialing. If your phone system 
does not require a delay after the 9 is dialed, you can manually delete 
the comma from the string. If you have a modem that is not Hayes 
compatible, you must change the comma to the delay character that is 
required for your modem.

iv) If you have touch tone service and you want to take advantage of it to 
speed up auto-dialing, click the 'Tone tone service' check box, this 
causes a 'T' to be prepended to the number. The 'T' is the instruction to 
tell a Hayes modem to use tone dialing. If you have a modem that is not 
Hayes compatible, do not click this check box.

v) If you have a non-Hayes compatible auto-dial modem that does not 
accept round brackets or dashes in the number then you must manually 
delete these characters from the number.

Note:
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For steps iii), iv) and v) above, do not perform any manual editing of the 
telephone number until after you have set the check boxes to the desired 
values. Clicking the check boxes causes your changes to be deleted.

4.4.3  User Id Command

If you use this command to enter your User Id and password Minitel/MAC will 
automatically supply them to the network for you during auto-logon. This 
saves you from manually having to enter them each time you log on or 
change services.

The User Id and Password that you enter are stored in the configuration file 
(usually 'mt.cfg'). Be sure not to give anyone a copy of this file.  If you are 
security conscious you may want to enter your User Id only and leave the 
password field blank. This way Minitel/MAC will automatically supply your 
User Id during auto-logon, but you must manually enter your password.

4.4.4  Terminal Command

This command allows you to modify parameters that are specific to the type 
of terminal that you are emulating. The dialog that appears is different 
depending on whether you are currently emulating a Minitel, VT100 or a TTY 
terminal.

4.4.4.1  Minitel Emulation

The 'Screen Mode' radio button allows you to set the terminal to either PAGE 
or SCROLL mode. In SCROLL mode attempting to move the cursor below the 
bottom line causes the screen to scroll up and moving it above the top line 
causes the screen to to scroll down. In PAGE mode moving the cursor below 
the bottom line causes it to move to the top and moving it above the top line
causes it to move to the bottom.  Normally there is no reason for switching 
from the default mode of PAGE as the HOST service that is sending data to 
your terminal will automatically switch the mode as required. Occasionally 
you may have to manually switch to SCROLL mode to 'Load Screens' that use
the scrolling feature of the terminal. See the 'Load Screens' command 
(section 4.2.2) for more details.
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The 'Terminal Type' radio buttons determine whether Minitel/MAC will display 
its output in color or in black and white (B&W)3. If your hardware is capable of
displaying at least eight colors or grey levels, set the terminal type to 
COLOR, otherwise set it to B&W. When the terminal type is set to B&W 
Minitel/MAC uses different patterns to simulate the eight Minitel colors.

If the Local Echo check box is set Minitel/MAC will echo all characters typed 
at the keyboard to the screen as well as sending them to the remote system.
This option is not normally required.If two copies of everthing that you type 
appears on the screen, turn this option OFF (i.e. uncheck the box).

Setting the 'X.3 Pad Compatibility' check box causes Minitel/MAC to send a 
different set of codes when the Minitel function keys are pressed (or clicked). 
These alternate set of codes are compatible with X.3 pads. Only use this 
option if specifically required by the service that you are using.

The 'Screen Save Format' radio buttons determine the format in which the 
screen is saved with the File menu Save Screen command.See section 4.2.2 
for more details.

4.4.4.2  VT100 Emulation

Setting the 'Local Echo' check box causes characters typed at the keyboard 
to be echoed to the screen as well as sent to the remote system. Set this 
check box if you do not see anything on the screen when entering data at 
the keyboard. If two copies of everthing that you type appears on the screen,
turn this option OFF (i.e. uncheck the box).

The 'Wrap text at right margin' check box determines what will happen when 
there is an attempt to write data past the right most column of the screen4. If
this check box is set the cursor will advance to the first column of the next 
row. If this check box is not set the cursor will stay on the right most column 
of the row.

3The terminal type can also be switched between B&W and COLOR by using 
the B&W/COLOR button at the lower right side of the terminal window.
4The right most column of the screen is either column 80 or column 132 
depending on whether the terminal is is 80 or 132 column mode.
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The 'Send Backspace when delete key pressed' check box determines what 
will be sent when the delete key on the Macintosh keyboard is pressed. If the
check box is set Minitel/MAC will send a backspace character (hex 8) when 
the delete key is pressed and a delete character (hex 7f) when the option 
key is held down and and the delete key is pressed. If the check box is not 
set Minitel/MAC will send a delete character when the delete key is pressed 
and a backspace character when the option key is held down and the delete 
key is pressed.

The 'Margin Bell' checkbox enables or disables the terminal margin bell. 
When the 'Margin Bell' checkbox is set and the 'Local Echo' checkbox is set 
the terminal will beep when you type past column 72 in 80 column mode and
column 124 when in 132 column mode.

The 'UK character set' check box causes a British pound symbol (£) to be 
displayed on the screen in place of the North American pound symbol (#).

The 'Line Feed/New Line mode' check box enables/disables the VT100 
feature of the same name. Setting this check box has the following effects:

i) Typing a CR (hex D) at the keyboard causes both a CR and LF (hex A) to 
be sent to the remote system.

ii) When a LF is received from the remote system both a CR and LF are 
displayed on the screen.

Use this option only is specifically required by the service that you are using.

The '9 point' and '12 point' radio buttons determine the size of the 
characters displayed on the screen. The '9 point' characters are smaller and 
allow 80 columns of information to be displayed on a small screen Macintosh 
(MAC Plus or SE). If you have a large screen Macintosh (Mac II, IIx, IIcx, etc) 
you will probably want to use the '12 point' setting in 80 column mode and 
the '9 point setting in 132 column mode.

The '80 columns' and '132 columns' radio button are used to put the terminal
into 80 column mode and 132 column mode respectively. Normally you 
should leave this setting at the default value of 80 
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since most services that require 132 column mode will automatically switch 
you into the required mode and back when needed.

The 'Answerback' field determines the value that is sent when the remote 
system requests an answerback. Unless the service that you are using 
requires a specific answerback you can leave the default value in this field.

4.4.4.3  TTY Emulation

Setting the 'Local Echo' check box causes characters typed at the keyboard 
to be echoed to the screen as well as sent to the remote system. Set this 
check box if you do not see anything on the screen when entering data at 
the keyboard. If two copies of everthing that you type appears on the screen,
turn this option OFF (i.e. uncheck the box).

Setting the 'Wrap text at right edge of window' check box affects what 
happens when data is written past the right edge of the window. With this 
option checked data wraps to the next line on word boundaries. With this 
option OFF (not checked) data is written past the right edge. In this mode 
you must use the horizontal scroll bar (the one at the bottom of the window) 
to see data past the left or right edges of the window.

4.4.5  Communications Command

This command allows you to set the communication parameters used on the 
serial interface that connects your Macintosh to the modem. You will not 
normally have to use this command as the defaults on this screen will work 
for most configurations.

The Speed radio buttons set the speed of the serial interface in bits per 
second. The first five options in the Modem command dialog automatically 
set the speed when they are selected. If you select one of the other modem 
options, you will have to manually set the speed. If you are using a modem 
such as a Microcom with allows you to set a speed between your computer 
and modem that is different than the one between your modem and the 
remote modem, set the speed radio button to the speed between your 
computer and modem. In this case, if the speed that you select is greater 
than the maximum speed supported at the phone number that you selected 
in the Telephone # dialog, the first time you LOGON you will be asked if you 
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want to reduce the speed to the max supported at that number (click NO).

The Parity, Data Bits and Stop Bits radio buttons set the remaining 
parameters on the serial interface. Most teletel (Minitel) services require 
even parity, 7 data bits and 1 stop bit. If these settings do not work (i.e. data
is garbled), check with your service provider to find out which settings are 
required.

The Connector radio buttons allow you to specify to which of the Macintosh 
serial ports your modem is connected. In the vast majority of cases you 
should connect your modem to the modem port.

Use the Flowcontrol radio button to set the flowcontrol as required by the 
service and modem that you are using. When accessing TTY services 
XON/XOFF flowcontrol is often used to keep you from losing data. CTS/RTS 
protocol is often required to keep you from losing data with modems that 
perform error correction or data compression (such as the Microcom). A 
flowcontrol setting of XON/XOFF is ignored during Minitel emulation mode 
(i.e. setting the flowcontrol to XON/XOFF in Minitel mode is the same as a 
flowcontrol setting of NONE).

4.4.6  Modem Config Command

The Modem Config command is only necessary if you selected a modem type
of Other in the modem dialog. It may also be necessary if you selected one 
of the Hayes modem options and you have a Hayes compatible modem that 
is not completely compatible with a real Hayes modem (such as a Microcom 
in Hayes mode).

The following sections describe each of the fields in the modem configuration
dialog.

Modem Initialization String

This is the string that must be sent to your modem to prepare it for a dial 
command. This string can also be used for a command to set the modem to 
a particular configuration. Entering a value in this field is optional. An 
example value for the Hayes modem is 'ATE1^M' 5 (turn on local echo in 
command mode).

5The '^M' in this example is a digraph meaning 'control M'. This particular 
digraph represents a carriage return (CR). See Appendix F (Entering Control 
Characters) for a complete description of how to represent control characters
in strings.
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Modem Response

Enter the string that the modem will send back in response to the modem 
init string.  Entering a value in response to this prompt is optional. For the 
Hayes modem the response would be '^M^JOK^M^J' (i.e. CR LF OK CR LF).

Modem Dial Prefix

This is the string that must precede the telephone number in a modem dial 
command. When issuing a dial request to the modem Minitel/MAC first sends 
the modem dial prefix, followed by the telephone number, followed by the 
modem dial suffix. For the Hayes modem the modem dial prefix is 'ATD'.

Modem Dial Suffix

This is the string that follows the telephone number in a modem dial 
command. When issuing a dial request to the modem Minitel/MAC first sends 
the modem dial prefix, followed by the telephone number, followed by the 
modem dial suffix. For the Hayes modem the modem dial suffix is '^M' (CR).

Success Responses

In response to this prompt you must enter all of the possible strings that the 
modem can send back to indicate a successful dial attempt. If you do not 
enter any success responses then Minitel/MAC will check for either an OFF to 
ON transition of carrier or a user command to determine success. The 
following list shows all possible success responses for the Hayes modem.

    ^M^JCONNECT^M^J
    ^M^JCONNECT 1200^M^J
    ^M^JCONNECT 600^M^J
    ^M^JCONNECT 2400^M^J

Up to eight modem success responses can be entered.
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Failure Responses

A failure response is a string sent by the modem to indicate that a dial 
attempt has failed.  The following list shows all possible failure responses for 
the Hayes modem.

    ^M^JNO CARRIER^M^J
    ^M^JBUSY^M^J
    ^M^JNO ANSWER^M^J
    ^M^JERROR^M^J
    ^M^JNO DIALTONE^M^J

Up to eight modem failure responses can be entered. Entering failure 
responses is not required but the advantage of using them is that the dial 
command will be able to detect a failure immediately rather than waiting for 
a timeout. A dial attempt will fail when a failure response is received, a 
timeout occurs or the user presses the ESC key or [command][.] during a dial
attempt.

4.4.7  Minitel Emulation Command

If not already emulating a Minitel terminal this command causes Minitel/MAC 
to start emulating a Minitel terminal.

4.4.8  VT100 Emulation Command

If not already emulating a VT100 terminal this command causes Minitel/MAC 
to start emulating a VT100 terminal.

4.4.9  TTY Emulation Command

If not already emulating a TTY terminal this command causes Minitel/MAC to 
start emulating a TTY terminal.

4.5  PK Keys Menu

The PF Keys menu contains the following commands.

-----------------
PF1 - #D
PF2 - #2
PF3 - #3
PF4 - #4
PF5 - #5
PF6 - #6
PF7 - #7
PF8 - #8
PF9 - #9
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PF0 - #0
-----------------
Modify...
-----------------
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The program function keys are used to extend the functionality of 
Minitel/MAC by adding your own commands.

A program function key can be used to execute a script language program 
(see Appendix E for instructions on writing your own script language 
programs) or to cause a pre-defined series of characters to be sent to the 
remote system as if they were typed at the keyboard.

The Modify command is used to modify the values of the program function 
keys. The Modify dialog allows you to enter a value for each of the ten 
program function keys. A pair of radio buttons for each key allows you to 
specify whether the value of that key represents a string to be sent to the 
remote system or the name of a file containing a script language program to 
be run.

The following special script file names (including the angle brackets) can also
be assigned to program function keys.

<DROPLINE/QUIT> This value causes Minitel/MAC to 
drop the line then exit to the 
Finder.

<DROPLINE> This value causes Minitel/MAC to 
drop the line. Same as the above 
value except Minitel/MAC does not 
exit to the finder.

<QUIT> This value cause Minitel/MAC to 
exit to the finder without dropping 
the line.

During Minitel emulation the program function keys PF1, PF2 and PF4 are set 
(in the default configuration file 'mt.cfg') to perform the following functions.
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PF1 LOGON TO NETWORK
Automatically dial and log on to the network. 
This is normally the first command that you will
issue after starting Minitel/MAC.

PF2 CHANGE SERVICE
When connected to a service this command 
can be used to return you to the service menu 
so that you can select a new service.

PF4 NETWORK LOGON
If you have an auto dial modem that does not 
work with PF1, you can manually instruct your 
modem to dial and then issue this command to
logon to the network.

The remaining program function keys are unassigned and can be used to add
your own commands to Minitel/MAC.  During TTY emulation all ten program 
function keys are available to add new commands to Minitel/MAC.

During Minitel emulation the program function keys PF1 and PF2 can also be 
started by the buttons (LOGON and CHANGSE respectively) at the lower right
side of the terminal window.

It is possible for the PF1, PF2 and PF4 commands to fail for a number of 
reasons, including, a bad communication line, a service not available, or 
network failure. See Appendix H (Error Messages) for a list of possible errors 
and instructions on how to recover in case of an error.

4.6  Help Menu

The help menu contains the following commands.

-----------------------
Read Me First...
Function Key Table... #H
-----------------------
Getting Started...
When Quitting...
-----------------------
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The commands on the help menu explain the basics of using Minitel/MAC for 
people who don't have time to read the manual (obviously you're not one of 
them).

The Read Me First command provides a brief explanation of the Minitel 
function keys for those who are not familiar with a real Minitel terminal.

The Function Key Table command displays a table showing the keyboard 
equivalent and the French Name of each of nine Minitel function keys. In 
some services the Minitel function keys are known by their French names.

The Getting Started command gives you a list of the minimum number of 
things that you must do to setup Minitel/MAC.

The When Quitting command provides brief explanation of the commands for
quitting from Minitel/MAC.

The help menu is not available during TTY or VT100 emulation.



Minitel/MAC33 12/31/22

APPENDIX A  Starting Minitel/MAC 

During startup Minitel/MAC reads the contents of a configuration file to 
determine hardware specific information and obtain function key and 
terminal settings (See Appendix C for a complete description of the 
configuration file). If you start Minitel/MAC by double clicking on the 
Minitel/MAC icon, the configuration file 'MT.CFG' will be used by default. In 
this case if the file 'MT.CFG' is not found in the same folder as the 
Minitel/MAC icon, a new configuration file with the name 'MT.CFG' is 
automatically created.

It is possible to have more than one configuration file. This is useful if you 
routinely access more than one service and you need to have different 
configuration parameters for each. For instructions on creating a new 
configuration file refer to section 4.2.1 (Configuration file commands) of this 
manual.

To start Minitel/MAC with a configuration file other than 'MT.CFG' double click 
on the icon for that configuration file.

Minitel/MAC can also be started by double clicking on the icon of a script 
program. In this case the script program will be run immediately after 
Minitel/MAC has started.

If you want to start Minitel/MAC with a configuration file other than 'MT.CFG' 
and also run a script program, select both the script program and 
configuration file icons, then double click on either one of them.
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APPENDIX B  Files that are distributed with Minitel/MAC 

The following files are distributed with Minitel/MAC.

MINITEL The Minitel/MAC Minitel terminal emulator
Minitel/MAC Manual The file that you are now reading.
PHONE.DAT Minitel Services Company telephone access listing

(used by the Telephone # command).
mtc Script Language Compiler
LOGON.MTO Script language program to dial and logon to the 

Minitel Services Company network (needed by the
Minitel/MAC PF1 command)

logon.mt Source code for the above program
CHANGESE.MTO Script language program which causes a 

disconnect from the current service and returns 
you to the menu so that you can select a new 
service (needed by the Minitel/MAC PF2 
command)

changese.mt Source code for the above program
NETLOGON.MTO Script language program to that logs on to the 

Minitel service network (needed by the 
Minitel/MAC PF1, PF2 and PF4 commands)

netlogon.mt Source code for the above program
mt.cfg Default configuration file



Minitel/MAC35 12/31/22

APPENDIX C  Configuration parameters 

This section describes the parameters in the Minitel/MAC configuration files. 
Configuration files have a file type of 'TEXT' and a creator of 'MTRM'. The 
configuration files contain one parameter per line.  Lines are separated by 
carriage return characters (hex d). All lines have the following format.

  parameter_name=parameter_value

The equal sign (hex 3D) separates the parameter name from its value. 
Control characters can be specified in the parameter value by using a 
circumflex (^) followed by another character. For example ^M (control M) 
can be used to specify a carriage return. Two circumflexes in a row can be 
used to specify a circumflex. See Appendix F for a detailed discussion on 
entering control characters in strings. The configuration lines are stored in 
the data fork of the file.

The following table describes all of the configuration parameters that are 
implemented in this version of Minitel/MAC.

C.1  Modem Paramters

Parameter Name Type Description

MODEM int Describes the type of modem. Valid 
values are:
 0 = HAYES300
 2 = HAYES1200
 4 = HAYES2400
 6 = MANUAL
 7 = DIRECT
 8 = OTHER
 9 = APPLE 300
10 = APPLE 1200

MODEM_INIT char Command that must be sent to 
initialize the modem (if any)

MODEM_RESPONSE char String that the modem sends in 
response to the initialization 
command.

MODEM_DIAL_PREFIX char String that must prefix the telephone 
number in a dial command

MODEM_DIAL_SUFFIX char String that must follow the telephone 
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number in a dial command

MODEM_SUCCESS char Specifies a successful response to a 
modem dial request. There can be 
more than one of these parameters 
present if there is more than one 
success response (maximum of ten).

MODEM_FAILURE char Specifies a failure response to a 
modem dial request. There can be 
more than one of these parameters 
present if there is more than one 
failure response (maximum of ten).
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C.2  User Information

Parameter Name Type Description

PHONE char Telephone number of nearest Minitel 
Services Company node (used when 
dialing)

LONGPHONE char Original version of the telephone # as 
it appears in the file PHONE.DAT

MAXSPEED int The maximum line speed supported at
the telephone # in LONGPHONE. 
When dialing, the current line speed is
checked to see if it exceeds 
MAXSPEED, if so, you are asked if you 
want to reduce the speed.

USERID char Network User ID
PASSWORD char Network password
LOGOFF_SCRIPT char Name of a script language program to 

be run whenever the line is dropped 
(prior to dropping the line).

SERVICE char Network service



Minitel/MAC38 12/31/22

C.3  Communication Parameters

Parameter Name Type Description

COMMPORT int Serial interface to use for 
communications (0=Printer port, 
1=Modem port)

SPEED int Communications speed in bits per 
second (one of 300, 1200, 2400, 
4800, 9600, 19200)

PARITY char Parity (one of O,E,N,S = ODD, EVEN, 
NONE, SPACE respectively)

DATABITS int Data Bits (either 7 or 8)

STOPBITS int Stop Bits (either 1 or 2)

BREAK_LEN int Duration of BREAK signal in 
milliseconds (used by the Command 
'B' and Option 'B' commands)

CARRIER_DETECTABLE int This parameter informs Minitel/MAC if 
the presence of carrier is detectable 
by looking at the state of the RS232 
CD pin. In the current version of 
Minitel/MAC the carrier is never 
detectable (0=carrier not detectable, 
non_zero=carrier detectable). This 
flag affects whether or not the 'C', 'L' 
connection indicator is displayed on 
the screen.

FLOWCONTROL int This parameter can have one of the 
following values.
 0 = NONE
 1 = XON/XOFF
 2 = CTS/RTS hardware protocol
(a setting of XON/XOFF is ignored 
during Minitel emulation)
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C.4  Display Parameters

Parameter Name Type Description

DISPLAY_ADAPTOR int How to display output on the screen (0
= Black & White with dithering, 1 = 
Color)

C.5  Program Function Keys

Parameter Name Type Description

PF1 char Setting of program function key 1
PF2 char Setting of program function key 2
PF3 char Setting of program function key 3
PF4 char Setting of program function key 4
PF5 char Setting of program function key 5
PF6 char Setting of program function key 6
PF7 char Setting of program function key 7
PF8 char Setting of program function key 8
PF9 char Setting of program function key 9
PF10 char Setting of program function key 10

Each program function key value is either blank or has the following
format.

Positions  Meaning

1  Type of value stored in the key. Must be one of the
 following.

     M   - A MACRO (script language program) to be run
     S   - A string to be sent

2  A single dash character ('-', hex 2D). This is just a
 separator to make the line readable.

3-  Function key value.

    Key Type  Meaning of value

    M   Name of file containing a the script
  language program to be run when this key is
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  pressed.

    S   String to be sent to the remote system when
  this key is pressed. Control characters can
  be specified in this string by using a
  circumflex (^) followed by another
  character (See Appendix F).

e.g.
To assign a HAYES dial command to program function key five the
following line could be added to the configuration file.

  PF5=S-ATDP438-8304^M
  ^  ^  ^           ^
  |  |  |           |
  |  |  |           The ^M specifies a carriage return
  |  |  Program function key value
  |  Program function key type
  Names the program function key to be set

The following special values can also be assigned to program
function keys.

M-<DROPLINE/QUIT> This value causes Minitel/MAC to 
drop the line then exit to the 
Finder.

M-<DROPLINE> This value causes Minitel/MAC to 
drop the line. Same as the above 
value except Minitel/MAC does not 
exit to the Finder.

M-<QUIT> This value causes Minitel/MAC to 
exit to the Finder without dropping 
the line.

C.6  Terminal Parameters

Parameter Name Type Description

EMULATION int Type of emulation to perform (0=TTY, 
1=MINITEL, 2=VT100).

ASCIIMODE int Type of emulation to switch to when a 
Teletel to Ascii switch is requested by 
the remote system (0=TTY, 
1=MINITEL, 2=VT100).

LOCAL_ECHO int Local echo on or off (0=OFF, 
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non_zero=ON).

PAGE_MODE int Page or scroll mode flag (0=SCROLL 
MODE, non-zero=PAGE MODE).

X3_MODE int X.3 pad compatibility mode enabled 
flag (0=OFF, non_zero=ON).

MTSAVEMODE int The format in which screens are saved
with the Save Screen command during
Minitel emulation (0=Minitel/MAC, 
1=MacPaint, 2=TEXT).

TEXTWRAP int Wrap text at right edge of window 
during TTY emulation (0=don't wrap 
text, non_zero=wrap text).

TTYBUFCHARS int The maximum number of characters 
to keep in the terminal buffer at one 
time during TTY emulation (default 
12,000)

TTYBUFDEL int The number of characters to delete 
from the TTY terminal buffer whenever
TTYBUFCHARS is exceeded (default 
6000)

TTYFONTTYPE char The name of the font to use on the 
screen during TTY terminal emulation. 
For best results this should be a fixed 
width font. The default font type is 
'VT100'.

TTYFONTSIZE int The font size to use during TTY 
emulation. The default is 9 (meaning 9
point)

VTANSWERBACK char During VT100 emulation this is the 
string that Minitel/MAC will send to the
remote system when an answerback 
is requested.

VTBSDELETE int During VT100 emulation this flag 
determines what will be sent when the
delete key is pressed on the MAC 
keyboard (0=delete, non-
zero=backspace).
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VTFONTSIZE int During VT100 emulation this is the 

size of the font that will be used for 
the characters on the screen (9=9 
point, 12=12point).

VTLINEWRAP int VT100 line wrap mode flag (0=no line 
wrap, non-zero=line wrap).

VTMARGINBELL int VT100 margin bell flag (0=disable 
bell, non-zero=enable bell).

VTUKSET int VT100 UK character set flag (0=use 
North American character set, non-
zero=use UK character set).

VTWIDESCREEN int VT100 screen width flag (0=80 
column mode, non-zero=132 column 
mode).

VT_LF_NL int VT100 Line Feed/New Line mode flag 
(0=OFF, non-zero=ON).
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APPENDIX D  Keyboard Mapping

The following describes the mapping of the Minitel keyboard to the 
Macintosh keyboard.

Single Codes

Code Sent (in 
hex)

Character Minitel Key(s) MAC Key(s)

00 NUL Ctrl' Ctrl @
01 SOH Ctrl A
02 STX Ctrl B
03 ETX Ctrl C
04 EOT Ctrl D
05 ENQ Ctrl E
06 ACK Ctrl F
07 BEL Ctrl G
08 BS Ctrl H
09 HT Ctrl I
0A LF Ctrl J or Ctrl: Ctrl J
0B VT Ctrl K or Ctrl; Ctrl 

K
0C FF Ctrl L
0D CR Ctrl M or Enter 

Ctrl M
0E SO Ctrl N
0F SI Ctrl O
10 DLE Ctrl P
11 Cursor ON Ctrl Q
12 REP Ctrl R
13 SEP Ctrl S
14 Cursor OFF Ctrl T
15 NACK Ctrl U
16 SYN Ctrl V
17 ETB Ctrl W
18 CAN Ctrl X
19 SS2 Ctrl Y
1A SUB Ctrl Z
1B ESC Esc Esc or Ctrl [
1C FS Ctrl , Ctrl | or Ctrl \
1D SS3 Ctrl - Ctrl } or Ctrl ]
1E RS Ctrl . Ctrl ^
1F US Ctrl ? Ctrl _
20 Space Spacebar Spacebar
21 ! SK 1 **



Minitel/MAC44 12/31/22
22 " SK 2 **
23 # # or SK 3 **
24 $ SK 4 **
25 % SK 5 **
26 & SK 6 **
27 ' 'or SK 7 **
28 ( SK 8 **
29 ) SK 9 **
2A * * or SK : **
2B + SK ; **
2C , , **
2D - - **
2E . . **
2F Box with diagonal

line
SK ? /

30 0 0
31 1 1
32 2 2
33 3 3
34 4 4
35 5 5
36 6 6
37 7 7
38 8 8
39 9 9
3A : :
3B ; ;
3C < SK , **
3D = SK - **
3E > SK . **
3F ? ? **
40 @ SK ' **
41 A A Shift A
42 B B Shift B
43 C C Shift C
44 D D Shift D
45 E E Shift E
46 F F Shift F
47 G G Shift G
48 H H Shift H
49 I I Shift I
4A J J Shift J
4B K K Shift K
4C L L Shift L
4D M M Shift M
4E N N Shift N
4F O O Shift O
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50 P P Shift P
51 Q Q Shift Q
52 R R Shift R
53 S S Shift S
54 T T Shift T
55 U U Shift U
56 V V Shift V
57 W W Shift W
58 X X Shift X
59 Y Y Shift Y
5A Z Z Shift Z
5B [ SK * **
5C 10 o'clock 

diagonal line
SK Cancel \

5D ] SK # **
5E Up Arrow SK 0 ^
5F Low horizontal 

line
Ctrl 6 _

60 Middle horizontal 
line

Ctrl 5 `

61 a SK A A
62 b SK B B
63 c SK C C
64 d SK D D
65 e SK E E
66 f SK F F
67 g SK G G
68 h SK H H
69 i SK I I
6A j SK J J
6B k SK K K
6C l SK L L
6D m SK M M
6E n SK N N
6F o SK O O
70 p SK P P
71 q SK Q Q
72 r SK R R
73 s SK S S
74 t SK T T
75 u SK U U
76 v SK V V
77 w SK W W
78 x SK X X
79 y SK Y Y
7A z SK Z Z
7B Left vertical line Ctrl 1 or SK {
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repeat

7C Middle vertical 
line

Ctrl 2 |

7D Right vertical line Ctrl 3 or SK send }
7E Upper horizontal 

line
Ctrl 4 ~

7F Filled in Box Ctrl <-- Ctrl delete



Minitel/MAC47 12/31/22

Sequences of two or three codes

Code sent (in 
hex)

Character Minitel Key(s) MAC Key(s)

19,23 British Pound Ctrl Cancel option 3
19,27 Section Mark SK Erase option .
19,2C Left Arrow Ctrl 8 option s
19,2E Right Arrow Ctrl 9 option g
19,2F Down arrow Ctrl # option 2
19,30 Degree Ctrl O shift option 8
19,31 Plus or minus 

symbol
Ctrl * shift option =

19,38 + Ctrl 7 **
19,41 ` (grave accent) SK Next option `
19,42 ' (accute accent) SK Previous option e
19,43 ^ (circumflex) SK Index option i
19,48 umlaut SK Guide option u
19,4B,63 c with cedilla Ctrl Erase option c
19,6A upper case 

diphthong 'OE'
Ctrl Previous shift option q

19,7A lower case 
diphthong 'oe'

Ctrl Repeat option q

19,7B Beta Ctrl Next option b



Minitel/MAC48 12/31/22

Sequences sent by function keys

Key or Combination of 
keys

MAC Key Codes Sent

Send Enter 13,41
Previous Command - or page up 13,42
Repeat Command R 13,43
Guide Command G 13,44
Cancel clear or end 13,45
Index Command I or home 13,46
Correction delete (non X.3 mode 

only) 
13,47

Next Command + or page 
down

13,48

Line/Local Command L 13,49-Modem
SK Line/Local (not supported on MAC)13,49-Socket
Ctrl Line/Local Command B Break to modem

Notes:

i) SK refers to the Special key on Minitel  and the Shift key on the MAC
ii) Where there is no MAC key specified the MAC key is the same as the 

Minitel key.
iii) '**' Means to use the Key marked for this purpose on your particular 

keyboard.
iv) Command refers to the command or apple key on the Macintosh 

keyboard.
v) Option refers to the option key on the Macintosh keyboard.
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APPENDIX E  Minitel/MAC Script Language

This section decribes the Minitel/MAC script language.

E.1  Script Language Compiler (MTC)

To create a script language program any text editor which creates a TEXT 
format file can be used.  The Minitel/MAC script language is a semi-compiled 
language. Once a script program has been created it must be compiled by 
the application 'MTC' (Minitel/MAC Compiler) before it can be executed. MTC 
checks the source for syntax errors and produces a compiled program as its 
result. Script source files are expected to have an extension of 'MT'.  MTC 
gives compiled scripts an extension of 'MTO' (Minitel/MAC Object).

To compile a script with MTC double click on the MTC icon then type the 
name of the file containing the program to be compiled when you see the 
following prompt.

  'Source file name ?'.

It is not necessary to specify the '.MT' extension of the source file name.

If you enter a carriage return only in response to the source file prompt, MTC 
will prompt you to enter the program source at the terminal. The following 
diagram illustrates the script creation process.

Create Script Source
file with text editor
(create myscript.mt)

   |
   |
  V
MTC
   |
   |
  V

    myscript.mto
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E.2  Running a Script Language Program

Scripts can be started by assigning them to a program function key then 
pressing the program function key at run time, by using the Run Script 
command on the file menu or by double clicking on a script program icon in 
the Finder.  Only one script language program should be specified at program
startup. If more than one is specified, only one is run.

While a script language program is running a reverse video 'M' appears on 
column 40 of the status row.  A running script language program can be 
aborted at any time by pressing the ESC key or by holding down the 
Command key and pressing the period key ('.').

E.3  Script Language Description

A Minitel/MAC script language program consists of a series of statements.  
Each statement can be preceeded by a label. A label consists of up to 15 
alphanumeric characters (and underscore) followed by a colon. The first 
character of a label must be alphabetic. Comments can be placed anywhere 
in a program by enclosing the comment within curly brackets ({}). The END 
directive must follow the last statement of a script language program (the 
END directive is a message to the script language compiler (MTC) informing 
it that it has reached the end of the program).

The following describes all of the script language statements.

E.3.1  DIAL statement

The dial statement causes the modem to dial the Minitel Services Company 
node using the Phone number and modem information from the Minitel/MAC 
configuration file. If the dial attempt fails, the script language program is 
aborted and a failure message is printed on the screen. The DIAL command 
supports all required modems for the HOST machine. For example on the 
MAC the DIAL command supports the Apple modems, HAYES modems, 
MANUAL dial modems, DIRECT modems and any command driven auto dial 
modem.

The following algorithm details the logic used by the DIAL command:

a) If the modem type is direct, terminate successfully otherwise proceed 
with step b).
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b) If the modem type is manual dial, proceed with step c) otherwise go to 
step e)

c) Prompt user to dial the number

d) Prompt user for a key;
If the user enters an ESC, terminate with failure
If the user clicks OK, terminate successfully
If the carrier signal goes from low to high while waiting for a key, 
terminate successfully.

e) If there is a MODEM_INIT parameter in the configuration file, send it and 
proceed to step f) otherwise proceed to step h).

f) If there is a MODEM_RESPONSE parameter in the configuration file, 
proceed to step g) otherwise wait till two seconds elapses with no data 
received from the remote system then proceed to step h).

g) If the modem response is not received within 10 seconds, terminate with
failure otherwise proceed to step h).

h) Build a dial command from the MODEM_DIAL_PREFIX, PHONE and the 
MODEM_DIAL_SUFFIX configuration parameters then send the dial 
command to the modem.

i) If there are no MODEM_SUCCESS configuration parameters, inform the 
user that a dial command has been sent and proceed to step d).

j) Wait for any of the MODEM_SUCCESS or MODEM_FAILURE responses to 
be received.
If 90 seconds go by with none of the success or failure responses 
received, terminate with failure.
If a success response is received, terminate successfully.
If a failure response is received, proceed to step k).

k) Prompt the user to see if he wants to try another dial attempt.
If 'YES', proceed to step e) otherwise terminate with failure.
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E.3.2  BRANCH statement

SYNTAX:   BRANCH label

The BRANCH statement causes program execution continue with the 
statement following the given label rather than the next statement.

  statement 1
  statement 2
  BRANCH skip
  statement 3
  statement 4

skip:   statement 5

In the above example the statements will be executed in the this order:

  statement 1
  statement 2
  statement 5

E.3.3  PAUSE statement

SYNTAX:   PAUSE tenths_of_second

The PAUSE statement causes the program to halt for the given number of 
tenths of a second before proceeding with the next statement.

e.g.   PAUSE 10   <- pause for 1 second

E.3.4  TYPE statement

SYNTAX:   TYPE string

The TYPE statement causes the characters in the given string to be sent to 
the remote system as though they were typed at the terminal.

The string can consist of any combination of the following.
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- a quoted string. The quoted string can contain diagraphs of the form 

'^letter' to include control characters in the string. For example the 
digraph ^M is a carriage return. See Appendix F for a complete 
description of digraphs. See notes at the end of section E.5 for more 
details on quoted strings.

- a Minitel function key (one of LOCAL_LINE, INDEX, CANCEL, PREVIOUS, 
REPEAT, GUIDE, CORRECTION, NEXT, SEND)

- a character constant (CR, LF, BS, BELL)
- any of the following configuration parameter names

    PASSWORD
    PHONE
    USERID
    SERVICE

e.g.
TYPE 'AT?' CR <- send string AT? followed by a CR
TYPE 'AT^M' <- same as above
TYPE 'CHAT' SEND <- send the string CHAT followed by the 

Minitel send key
TYPE USERID CR <- send the value of the configuration 

file USERID parameter followed by a 
CR (carriage return)

E.3.5  QUIT statement

Terminates execution of the current script program.

E.3.6  DOPF statement

SYNTAX:   DOPF number

Causes the named program function key to be executed. This causes the 
same effect as the user pressing the given function key at the keyboard. 
Script language programs can invoke other script language programs using 
function keys.

e.g.   DOPF 2 <- execute PF2

E.3.7  MESSAGE statement

SYNTAX:   MESSAGE string



Minitel/MAC54 12/31/22
This command causes the given string to appear in a dialog on the screen. 
The dialog has an OK button. After the user clicks the OK button the dialog 
disappears and the underlying screen is restored. The string containing the 
message to be printed must have the same format as a string in a TYPE 
statement.

e.g.   MESSAGE 'Logon Procedure has failed'

E.3.8  LOOP statement

SYNTAX:
  LOOP number

statements
AT_END_DO
    statements

  ENDLOOP

The LOOP statement causes the statements between the LOOP keyword and 
the AT_END_DO clause to be executed 'number' times. After the last time the
statements following the optional AT_END_DO clause are executed. The loop 
can be terminated prematurely by using the BREAK statement or the 
BRANCH statement. The BREAK statement causes program execution to 
continue following the ENDLOOP clause. If the loop is terminated prematurely
for any reason, the statements following the AT_END_DO clause are not 
executed. The BREAK statement is ignored if it is encountered anywhere 
other than within a LOOP.

e.g.
  LOOP 3

type 'hello' CR
AT_END_DO
    type 'this is the last hello'

  ENDLOOP

The above example causes the following data to be sent to the remote 
system.

  hello
  hello
  hello
  this is the last hello
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e.g. 2

  LOOP 2
TYPE 'I am about to pause for 5 seconds'
PAUSE 50

  ENDLOOP

The above example demonstrates a loop statement without an AT_END_DO 
clause.

E.3.9  WAIT statement

SYNTAX:
  WAIT tenths

CASE string 1
    statements
CASE string 2
    statements
    .
    .
CASE string N
    statements
FAILURE
    statements

  ENDWAIT

The WAIT statement causes the script program to WAIT for data from the 
remote computer system. If a string named by one of the CASE clauses is 
received from the remote system, the statements following that CASE clause 
are executed. If 'tenths' tenths of a second go by with no data received from 
the remote system, or if the line drops,  the statements following the 
optional FAILURE clause are executed. After the statements following a CASE 
or FAILURE clause are executed execution continues after the ENDWAIT 
clause.

The string parameter of the CASE clause must have the same format as a 
string in a TYPE statement. Multiple strings can be specified by separating 
them with a comma (,). If there are multiple strings separated by a comma, 
the statements following the CASE clause are executed if any one of the 
named strings are received from the remote system.

e.g.
  TYPE 'ATDP 438-8304' CR
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  WAIT 600 { wait up to 60 seconds (600 tenths) }

CASE 'CONNECT', 'CONNECT 1200', 'CONNECT 2400'
    { the dial attempt has succeed so just continue }
    { with the statement following the ENDWAIT }
CASE 'NO CARRIER', 'BUSY', 'NO ANSWER'
    MESSAGE 'Dial attempt has failed, try again later'
    QUIT
CASE 'ERROR', 'NO DIALTONE'
    MESSAGE 'Fatal error during dial attempt'
    QUIT
FAILURE
    MESSAGE

'Timeout, line lost or user ESC during Dial Attempt'
    QUIT

  ENDWAIT
  WAIT 5

CASE CR LF { wait for rest of modem response }
  ENDWAIT

In the above example we send a dial request to a HAYES modem and use the
WAIT statement to check the result (note that you would not normally have 
to do this since the above and more can be performed automatically by the 
DIAL command).

e.g. 2
  LOOP 10

TYPE CR
WAIT 3 CASE '#' BREAK ENDWAIT

AT_END_DO
    MESSAGE 'PAD not responding with a # prompt.'
    QUIT

  ENDLOOP

In the above example we send up to 10 carriage returns (one every three 
tenths of a second) in an attempt to get a '#' prompt from a Minitel Services 
Company PAD. The WAIT statement waits up to three tenths of a second for a
'#', if it fails there is no effect (since there is no FAILURE clause). If the WAIT 
statement succeeds then the BREAK statement is executed and the LOOP 
terminates prematurely. If the loop terminates prematurely then the 
statements following the AT_END_DO clause are not executed. Note that 
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statements can be split over multiple lines.  The above WAIT statement 
would be more clearly written as;

  WAIT 3
CASE '#'
    BREAK

  ENDWAIT

E.3.10  IF statement

SYNTAX:
   IF string THEN

statements IF string THEN
   ELSE OR statements

statements ENDIF
   ENDIF

The IF statment tests the value of 'string' for a non-null value. If 'string' has a
non-null value, the statements between the THEN and ELSE clauses are 
executed, otherwise the statements between the ELSE and ENDIF clauses are
executed. The ELSE clause is optional. If there is no ELSE clause, the 
statments between the IF and ENDIF clauses are executed if 'string' has a 
non-null value, otherwise execution continues after the ENDIF clause.

e.g.

  { if there is a phone # in the config file then  dial }
  if phone then

message 'Your local access # is ' phone
dial

  else
message 'No PHONE parameter specified in config file'

  endif

e.g. 2

  { if there is a password in the config file then send it }
  if password then

type password SEND
  endif
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E.4  Script Program Example

The following example is a complete script language program that dials the 
Minitel Services Company network and requests a service.

   { logon.mt - script program to dial the Minitel services company
     network and request a service }

   dial   { dial Minitel Services Company network
    - uses config modem type & number }

   { try up to six times to get a pound sign }
   loop 6

  type CR
  wait 3 case '#' break endwait

  at_end_do
message 'PAD not responding with #'
quit

   endloop

   { perform network logon }
   type 'x' CR
   wait 50

  case '*' { success }
  failure

message 'PAD not responding with *'
quit

   endwait

   type '.vmt' CR { request network service }
   end

E.5  Detailed Script Language Syntax Definition

The following defines the syntax of all legal script language programs.

Program -> Lines END
Lines -> Lines Line

-> Line
-> <empty>

Line -> Label Statement
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Label -> <identifier> :

-> <empty>
Statement -> WAIT <integer> Waitcases Failcase ENDWAIT

-> LOOP <integer> Lines Endstmnts ENDLOOP
-> IF Charexp THEN Lines ElseIf ENDIF
-> MESSAGE Charexp
-> DOPF <integer>
-> DIAL
-> BRANCH <identifier>
-> PAUSE <integer>
-> QUIT
-> TYPE Charexp
-> BREAK

Waitcases -> Waitcases Waitcase
-> Waitcase

Waitcase -> CASE Charexplist Lines
Charexplist -> Charexplist , Charexp

-> Charexp
Failcase -> FAILURE Lines

-> <empty>
Endstmnts -> AT_END_DO Lines

-> <empty>
ElseIf -> ELSE Lines

-> <empty>
Charexp -> Charexp Charterm

-> Charterm
Charterm -> Envcharvar

-> Charconst
-> Functionkey
-> <string>

Charconst -> CR
-> LF
-> BS
-> BELL

Envcharvar -> PF1
-> PF2
-> PF3
-> PF4
-> PF5
-> PF6
-> PF7
-> PF8
-> PF9
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-> PF10
-> PASSWORD
-> PHONE
-> USERID
-> SERVICE

Functionkey -> LOCAL_LINE
-> INDEX
-> CANCEL
-> PREVIOUS
-> REPEAT
-> GUIDE
-> CORRECTION
-> NEXT
-> SEND

Notes:

i) <empty> means that the construct is optional.

ii) <identifier> is an identifier of up to 15 alphanumeric characters (and 
underscore) in length. The first character of an identifier must be 
alphabetic.

iii) <string> is a character string enclosed in single quotes. Single quotes 
can be included within the string by putting two of them together. For 
example to specify the string;

that's all folks

you would enter

'that''s all folks'.

iv) <integer> is an integer value in the range -32768 to 32767. Values 
outside this range will cause undefined results.

v) Comments can appear anywhere in the program except within a token.

Examples:

  WAIT { this is a legal comment } 10
CASE 'hello'
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  ENDWAIT

  WAI{ this comment causes an error }T 10
CASE 'hello'

  ENDWAIT



Minitel/MAC62 12/31/22

APPENDIX F  Entering Control Characters 

Control characters can be entered into configuration file parameters, literal 
strings in script language programs, and in dialogs by using a two character 
digraph of the form ^x where '^' is the circumflex character (ascii 94) and 'x'
is any other character. The sequence ^x causes the control character whose 
value is the ascii value of the upper case version of the character minus 64 
to be entered into the string. For example ^m causes a carriage return to be 
entered into the string (the ascii value of an upper case 'm' is 77. Seventy-
seven minus 64 is equal to 13 which is the ascii value of a carriage return).

The following table lists a number of useful digraphs:

Digraph Control 
Character 

Ascii Value

^M CR 13
^J LF 10
^H BS 8
^G BELL 7
^L FF 12
^I TAB 9
^[ ESC 27

The following digraph/character combinations can be used to encode Minitel 
functions keys within a string.

Code Function Key Ascii Values

^SA SEND 19 65
^SB PREVIOUS 19 66
^SC REPEAT 19 67
^SD GUIDE 19 68
^SE CANCEL 19 69
^SF INDEX 19 70
^SG CORRECTION 19 71
^SH NEXT 19 72
^SI LOCAL/LINE 19 73
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Note that the above function key coding represents the non-X.3 compatible 
version of the function keys. Within script language programs you should 
always use the function key names rather than the digraphs, because the 
function keys names will cause the correct sequence to be sent depending 
on whether or not you are in X.3 compatible mode.

If you wish to enter a circumflex (^) in a string as itself, you must put two of 
them in a row. If you enter a sequence in a string of the form ^x in a string 
and the ascii value of the character x is less than 64, the circumflex (^) is 
ignored.
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APPENDIX G  Use of the Minitel Function Keys 

The following tables describe the most common meaning of each of the 
Minitel function keys. Pressing the asterisk key (*) prior to a function key 
modifies the meaning of a number of the keys.

FUNCTION KEY MEANING

LOCAL LINE Causes a disconnection from the current 
service.

SEND Validation of character strings or completion 
of a form.

REPEAT Causes service to retransmit the previous 
screen. Used to clear transmission errors.

* REPEAT Refresh the current display with updates 
made since the previous request.

INDEX Return to the index of the service in use.

* INDEX Access to the index at the highest level in the
case of a hierarchical index.

GUIDE Request HELP from the service.

CORRECTION Used to erase the last character typed.

The following function keys have slightly different meanings depending on 
whether you are in a data entry screen or whether you are giving a 
command to an application.

FUNCTION KEY MEANING IN A DATA ENTRY 
SCREEN

MEANING AS A 
COMMAND TO AN 
APPLICATION

CANCEL Deletes the contents of the 
current field.

Abort current enquiry.

* CANCEL Delete all fields on the 
current form and move to 
the first field.

No Meaning

NEXT Move to following field. Move to following page.
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PREVIOUS Move to previous field. Move to previous page.

* NEXT Move to following page. Move to following 
document.

* PREVIOUS If there is a previous page, 
return to the first field of 
the previous page, 
otherwise move to the first 
field of the current page.

Return to the last page 
or message.
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The above tables were adapted from tables in the Intelmatique document 
titled 'USE OF THE MINITEL FUNCTION KEYS'.
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APPENDIX H  Error Messages 

This appendix lists the most common error messages that can occur and 
recommends corrective that can be taken for each.

If the suggested corrective action fails for the following group of commands, 
try exiting Minitel/MAC (with the 'Quit & Drop Line' command), restarting 
Minitel/MAC, and then using the PF1 command (or click the LOGON button) to
restart.

Command(s) Error and Corrective Action

PF1 "Timeout or Line Lost while Dialing"

Retry the PF1 command.

PF1 "Modem not responding to init string"

Make sure that your modem is connected and 
powered on, then retry the PF1 command.

PF1 "DIAL Attempt has Failed."
"Try Again ?"

Click the YES button if you want Minitel/MAC to 
try again. If you want to quit click the NO button,
then issue the 'Quit & Drop Line' command. If 
you want to try dialing manually, click NO, then 
enter the dial command. If you get a connection 
by dialing manually you can use the PF4 
command to logon to the network.

PF1, PF2, PF4 "PAD not responding with #"
"PAD not responding with *"
"Unable to connect to network service"

If any of the above errors occur, issue the PF4 
command (even if the error occured in a PF1 or 
PF2 command).

PF1, PF2, PF4 "User ID prompt not received"

If this error occurs, exit Minitel/MAC with the 
'Quit & Drop Line' command, then start again.
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If any of the following errors occur, you must use the finder or use one or 
more of the commands on the Options menu to take corrective action.

Command(s) Error and Corrective Action

PF1 "Error: No PHONE param in config file"

To use the auto dial feature of Minitel/MAC you 
must enter a Telephone number using the 
Telephone # command on the Options menu.

Save, Quit, Save As, 
Quit & Drop Line

"Error saving config to <xxx>"

The above error is displayed when Minitel/MAC is
unable to save the configuration to a file. 
Possible reasons include a full disk or bad disk 
sectors. To correct the problem try deleting 
unnecessary files from the disk or move 
Minitel/MAC onto a different disk.

PFx "Script <xxx> not found."

This error will occur if Minitel/MAC does not find 
the script language program to be run in the 
current folder. This can happen if one of the file 
commands causes the current folder to be 
changed. After you click OK to acknowlege the 
message Minitel/MAC will present the standard 
file open dialog so that you can show it where to 
find the script.

PFx "Error reading <xxx>"
"Aborting Script - Bad Instruction"
"Aborting Script - Bad env var"
"Aborting Script - Bad function key"
"Aborting Script - Bad char item"

If any of the above errors occur, the script 
program that was running when the error 
occurred has become corrupted. Try recompiling 
the script program with MTC.

PFx "Illegal value in key PFx"
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This error occurs if there is a bad definition for 
the program function key PFx in the 
configuration file. Possible errors are;

- A character other than an upper case 'M' or 'S' 
was specified as the first character of the key 
definition.

- A character other than '-' was specified as the 
second character of the key definition.

To correct this problem fix the program function 
key definition in the configuration file or use the 
Modify command on the PF Key menu and 
reenter the value for the key.
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APPENDIX I  TTY Emulation 

This section describes the use of the TTY emulation mode of Minitel/MAC.

During TTY emulation up to the last 12,000 characters displayed on the 
screen are saved. This saved data is called the TTY terminal buffer. Data in 
this buffer that has scrolled off the screen can be viewed by using the scroll 
bar at the right side of the terminal window.

Data to the left and right edges of the terminal window can be viewed by 
using the scroll bar at the bottom edge of the terminal window.

The TTY emulator is always in one of two modes depending on the position of
the insertion point. If the insertion point is on the last row of the screen and 
no selection is active, the TTY emulator is in REMOTE mode. At any other 
time the TTY emulator is in LOCAL mode.

In REMOTE mode characters typed at the keyboard are sent to the remote 
system and the editing of data on the screen is handled as on a TTY terminal 
(i.e. Minitel/MAC behaves as a normal TTY terminal).

In LOCAL mode characters typed at the keyboard only affect the local screen 
and are NOT sent to the remote system. In this mode the editing of data on 
the screen is handled as in a MAC word processor or text editor. LOCAL mode
allows you to resend previous commands on the screen or edit data on the 
screen and transmit that data to the remote system.

The following section describes the use of the commands on the edit menu 
during TTY emulation.

I.1  Undo command

The undo command is not supported during TTY emulation. It is only included
to support desk accessories that require this feature.
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I.2  Cut command

The Cut command moves the current text selection from the screen to the 
Minitel/MAC clipboard.

I.3  Copy command

The Copy command copies the current text selection from the screen to the 
Minitel/MAC clipboard.

I.4  Paste command

Replace the selected text on the screen with the contents of the Minitel/MAC 
clipboard. If there is no selected text, insert the contents of the Minitel/MAC 
clipboard onto the screen at the insertion point.

If currently in REMOTE mode the contents of the Minitel/MAC clipboard are 
also sent to the remote system.

The following technique can be used to submit data or commands on the 
screen to the remote system:

i) Move to a position in the screen buffer (using the scroll bars) where 
there is data that you want to send to the remote system

ii) Select the data on the screen with the mouse

iii) Move the selected text to the clipboard with the Copy command

iv) Move back to the end of the screen with the vertical scroll bar

v) Move the insertion point to the last line of the terminal buffer by clicking 
with the mouse

vi) Use the paste command to send the data to the remote system

A shortcut to the above technique is to follow steps i) and ii) then hit the 
Enter key. The Enter key automatically performs steps iii) thru vi). If there is 
no selection active the Enter key just moves you to the end of the screen (i.e.
puts you back into REMOTE mode).
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I.5  Clear command

The clear command deletes all selected text from the terminal buffer. If there
is no text selected, this command has no effect.

I.6  Select All

The Select All command causes all text in the terminal buffer to be selected.
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APPENDIX J  Modem Switch Settings 

This section specifies the switch settings that are recommended for the 
modems that are supported by Minitel/MAC.

J.1  Hayes 300 and Hayes 1200 external modems

switch: 1  2 3  4 5  6 7  8
setting: -  - -  - -  U -  D

D = down, U = up, - = don't care

J.2  Hayes 2400 external modem and direct connection

Nothing needs to be set with these modems.

J.3  Manual Dial modems and Other Modems

For best results these modems should be configured so that:

-> DCD tracks the state of the data carrier from the remote modem. 
-> An ON to OFF transition of DTR causes the modem to drop the line.

If the modem is command driven it is recommended that you put the 
commands that configure the modem as above in the modem init string 
(using the Option menu 'Modem Config' command).
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APPENDIX K  Version Differences 

Differences between Minitel/MAC version 1.0 and 1.10.

1) File transfer capability added during Minitel Emulation (using xxx 
protocol).

2) A session capture command was added to the File menu. This command 
works across all emulations and saves the text of the session to a disk 
file.

------------------------------------------------------------------------

Differences between Minitel/MAC version 1.0 and 1.10.

1) The VT100 emulation mode was added.
2) A number of the Minitel mode keyboard assignments were changed to 

make the emulator compliant with TOG standards.
3) Acknowlegements are now sent to the remote system for the Teletel to 

Ascii switch and Ascii to Teletel switch.
4) A new configiration parameter (ASCIIMODE) determines whether VT100 

emulation or TTY emulation is to be used when the remote service 
requests a Teletel to Ascii switch.

5) The Minitel emulator now sends X.3 compatible versions of the reset 
sequence and terminal id request acknowlegements when in X.3 pad 
compatibility mode.

6) The LOGOFF button was removed from the screen. The 'Quit and Drop 
Line' command now performs the function of the LOGOFF buttom.

7) A new button has been added that allows you to quickly switch between 
the black&white and color modes without having to go through the 
Terminal dialog.
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APPENDIX L  Differences from a real Minitel 

Minitel/MAC emulates the Videotex mode of the Minitel M1B terminal except 
for the following differences (ascii and mixed modes are not implemented).

1) A Minitel is capable of displaying double high and double size characters
with different colors on the top and bottom rows. Minitel/MAC always 
displays double high/size characters with the same color on both rows 
using the color of the lower row.

2) None of the CSI formatting functions are implemented.  CSI sequences 
are filtered but are not acted upon.

3) The only software protocol commands and features of the software 
protocol that have been implemented are;

  - scroll mode on/off (no acknoledgement returned)
  - reset to power on state (acknowledgement returned)
  - ID request (The seqence SOH (01 hex) Cu7 EOT (04 hex)
    is returned in response to the ID request. The sequence
    SOH Cuw EOT is returned when Minitel/MAC is in X.3 pad
    compatibility mode. These are the same as the sequences
    that are returned by the Telic Alcatel M1B terminal)

Protocol commands that have not been implemented are filtered out by 
Minitel/MAC so that they do not appear on the screen.

5) When overwriting a double width character with a single width character
a Minitel shifts the double width character to the right one space. This 
was not implemented in Minitel/MAC.

6) When overwriting the right half of a double width character a Minitel 
displays the character one space to the right. This is not implemented in
Minitel/MAC.

7) Minitel/MAC implements a TTY terminal emulation mode and a VT100 
terminal emulation mode. When the remote service requests a switch 
from Teletel to Ascii mode either the VT100 mode or TTY mode is used 
depending on the value of the ASCIIMODE configuration file parameter.
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8) Keyboard differences noted in Appendix D. The extended keyboard mode
is not implemented.

9) The error correction protocol has not been implemented.

10) The screen transparency commands have not been implemented.
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APPENDIX M  VT100 emulation

The following tables describe the keyboard mapping during Minitel/MAC 
VT100 terminal emulation.

VT100 Key Macintosh Key Alternate MAC Key 
Combination

PF1 clear (keypad) Shift Option 1
PF2 = (keypad) Shift Option 2
PF3 / (keypad) Shift Option 3
PF4 * (keypad) Shift Option 4
left-arrow left-arrow Option a
right-arrow right-arrow Option s
up-arrow up-arrow Option w
down-arrow down-arrow Option z
BREAK Option b
SHIFT BREAK Shift Option b
RETURN return enter
DELETE delete Option delete (if set in 

VT100 screen dialog)
BKSP Option delete delete (if set in VT100 

screen dialog)
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The mapping of the following keys is specific to the keypad application mode 
of the VT100.  Keys on the VT100 keypad map to keys in the same position 
on the MAC keypad.  Alternates are provided for the older keyboards that do 
not have the built-in keypad.

VT100 Keypad Key Macintosh Keypad Key Alternate MAC Key 
combination

1 1 Option 1
2 2 Option 2
3 3 Option 3
4 4 Option 4
5 5 Option 5
6 6 Option 6
7 7 Option 7
8 8 Option 8
9 9 Option 9
0 0 Option 0
. . Option .
, - Option ,
- + Option -
ENTER enter Option return


